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Thank you for choosing the Microscope Anyty ViewTer 500 IR/UV!

This extremely compact digital microscope magnifies the subject up to 
200 times! The microscope is very handy, stable and has the dimensions 
of a digital camera. ViewTer 500 is available with either UV LED or IR LED 
illumination.

You can use the ViewTer 500 microscope for a wide range of applica-
tions, such as:

• Industrial inspection

• Computer parts inspection

• Telecommunication module inspection

• Scientific teaching tool

• Medical analysis

• School research tool

• Insect section / examination

• Plant dissection / examination

• Skin analysis

• Textile inspection

• Inspection of collections / coins / jewellery

• Pressure testing

And much more ...



3

Contents.

1. Content .......................................................................................................................04
2. Description of the device parts..........................................................................05
3. First use .......................................................................................................................07
	 .3.1 Charging...............................................................................................................07
	 .3.2 Inserting SD card...............................................................................................07	
	 .3.3 Attaching the lens cover and spacers........................................................08
	 .3.4 Changing the magnification and focus....................................................08
	 .3.5 Connecting the remote control...................................................................08
4. Using the ViewTer....................................................................................................09
	 .4.1 Switching on the device.................................................................................09
	 .4.2 Changing the magnification and the zoom............................................09
	 .4.3 Digital zoom........................................................................................................09
	 .4.4 Adjusting the LED.............................................................................................09
	 .4.5 Display scale........................................................................................................09
	 .4.6 Recording a still image....................................................................................09	
	 .4.7 Recording a video.............................................................................................10
	 .4.8 Preview of recorded data ..............................................................................10

5. Settings........................................................................................................................11
	 .5.1 Still image mode settings..............................................................................11
	 .5.2 Video mode settings........................................................................................12
	 .5.3 Preview mode settings....................................................................................12
	 .5.4 ViewTer main settings......................................................................................13
6. Software (ViewTer Plus).........................................................................................14
	 .6.1 Installing the software.....................................................................................15
	 .6.2 Transmitting / Deleting the recorded data..............................................17
	 .6.3 Using ViewTer Plus............................................................................................20	

7. Advices and FAQ......................................................................................................25
8. Specifications............................................................................................................26
9. Safety advices............................................................................................................27



4

1. Content

The product includes the parts listed below. Please check that the delivery is 
complete. A description of the parts (except the spacers) can be found on the 
following pages.

1

2

3 4

1 ViewTer 500 UV/IR 6 Mini-USB charging cable
2 Spacer 7 Shoulder laces
3 Lens cover 8 Measuring scale
4 Remote control 9 SD card
5 USB charging cable 10 Cleaning tissue
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2. Description of the device parts

1 On/Off button Switching the device on and off

2 Release button Button for taking pictures/videos

3  Remote control connection Connection for remote control

4 Tab holder Tab for the carrying strap

5 Lens cover Lens with lens cover

6 Charging display Red light during charging

7 LED controller Set the brightness of the LED

8 Mini-USB connection For connecting to the PC

9 Charging port Connection for charging the device
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	 Remote control

10 Display Showing microscope picture and information

11 Magnification controller Changing of magnification/focus

12 SD/SDHC slot Slot for SD card

13 LED button Changing LED mode

14 Menu button Showing the setting

15 Mode button Changing mode

16 Direction buttons Navigating through the menu

17 Confirmation button Confirming the selection

18 Digital zoom Changing the digital zoom

Switch on the LED

Changing mode

Release
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3. First use

3.1 Charging
Please charge the ViewTer microscope before using it for the first time. 
Use the attached USB charging cable. The charging lamp lights up red 
during charging. The charging time is about 4-5 hours. The charging 
light turns blue when charging is completed. Please charge the battery 
completely before using the device for the first time.
We recommend not to use the device while charging, otherwise the 
battery life time may be shortened.

3.2 Insert SD card
Pictures taken by the ViewTer are saved on the SD card. Please insert a 
SD card into the SD/SDCH card slot. The maximum usable size for the SD 
card is 32 GB. If you are using a MicroSD/SDCH card, make sure that the 
MicroSD/SDCH card is correctly placed in the adapter. If the card cannot 
be read correctly, remove the card from the device and reinsert it.

LED charge display

Charging port

USB port
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3.3 Attaching the lens cover and spacers
The apparat includes two sets of lens covers and spacers:
For x60 + x200
For x80 + x150
Change the covers and spacers to obtain the desired magnification. To 
remove the spacers, simply pull them off the lens.

3.4 Changing the magnification and focus
Turn the magnification controller to adjust the focus while shooting. 
This picture shows the magnification and focus distances.

3.5 Connecting the remote control
Connect the remote control if you want to use the unit e.g. with a tripod. 
Please connect the cable of the remote control to the corresponding 
connection on your ViewTer microscope. 
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4. Using the ViewTer

4.1 Switching on the device
Switch on the device. Press the on/off 
button for one second and the display will 
switch on. The device switches off in the 
same way.

4.2 Changing the magnification and the zoom
Bring the lens cover close to the object. The image 
of the object is shown on the screen. Use the mag-
nification controller to adjust the magnification and 
the focus.

4.3 Digital zoom
You can also use the digital zoom to adjust the magnification. Press the 
+/- buttons next to the display to adjust the magnification of the digital 
zoom. The maximum zoom is x4. If you use the digital zoom, the image 
quality will deteriorate.

4.4 Adjusting the LED
Press the LED button to switch between the following LED modes: light 
off -> white LED -> UV LED/IR LED. To adjust the brightness, please use 
the LED controller on the side of the device. 

4.5  Display scale
Press the "OK" button for a few seconds during video mode to show the 
display scale. You can use the scale to adjust position and size. The scale 
is only showed on the display and is not saved in the data.

4.6 Recording a still image
Press the release button next to the power button and the display turns 
black. This is the sign that the ViewTer is recording.

Display in still mode
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1	 Still mode
2	 Free memory space
3	 SD card
4	 Media format
5	 Battery display
6	 Current date and time

4.7 Recording a video
Press the mode button to switch to video mode. Press the release button 
to start recording. Press the button again to stop recording the video.

1	 Video mode
2	 Free memory space
3	 SD card
4	 Media format
5	 Battery display
6	 Current date and time

4.8 Preview of recorded data
Press the Mode button twice to switch to preview mode. To play videos, 
press the release button.

1	 Preview mode
2	 Only for videos: Length of the recording
3	 SD card
4	 Media format
5	 Battery display
6	 Preview data number                 

                        7          Only for videos: Press the release button            

       

to start the video.
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5. Settings

This section explains the modes and settings. Press the menu button in 
each mode to open the settings menu and use the directional pad to 
navigate.

5.1 Still image mode settings
Settings in still image mode

To open the main settings go to point 5.4 (page 13)

Change colour
You can change the colour of the data to be saved.
	 Normal	 Standard setting, all colours

	 Grey scale	 Black/White

Changing the resolution
Choose between five different resolutions. Large resolutions produce 
high-resolution images, but the size of the saved files is also increased.

	 500M	 Data is saved in 2060 x 1920 pixels
	 300M	 Data is saved in 2048 x 1536 pixels
	 200M	 Data is saved in 1600 x 1200 pixels
	 100M	 Data is saved in 1280 x 960 pixels
	 VGA	 Data is saved in 640 x 480 pixels

Image stabilisation system

Prevents blurring due to camera shake when taking pictures. If there is 
too much shaking, the system may not work properly.

	 On	 Image stabilisation system is on
	 Off	 Image stabilisation system is off
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5.2 Video mode settings

   	Settings in video mode

White balance

	 Normal		  Normal white balance
	 Outside (Sunny)	 Setting for an environment where the 	
			   light is strong
	 Outside (Cloudy)	 Setting for an environment where the 	
			   light is weak
	 Incandescent lamp	 Setting for an environment in which an 	
			   incandescent lamp is
	 Fluorescent lamp	 Setting for an environment in which a 	
			   fluorescent lamp is

Changing the resolution

Choose from two different resolutions. Large resolutions produce 
high-resolution videos, but the size of the saved files also becomes 
larger.
	 VGA	 640 x 480 pixel
	 QVGA	 320 x 240 pixel

5.3 Preview mode settings

Settings in preview mode

Rotate the image (only for images)
You can rotate the images during the preview.	

90	 Rotation of the image by 90° clockwise
180	 Rotation of the image by 180° clockwise
270              Rotation of the image by 270° clockwise
Cancel        Exit the setting

File protection
You can protect a file from being deleted by locking it.

	 Protect	 Activating the protection
	 Unlock	 Deactivating the protection
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Delete files
You can delete one or more files.

	 Current picture	 Delete the current picture/video
	 All		  Delete all data on the SD card
	 Cancel 		  Exit the setting

5.4 ViewTer main settings

Exposure

Setting the white balance
Setting the white balance for taking a still image

	 Normal		  Normal white balance
	 Outside (Sunny)	 Setting for an environment where the 	
			   light is strong
	 Outside (Cloudy)	 Setting for an environment where the 	
			   light is weak
	 Incandescent lamp	 Setting for an environment in which an 	
			   incandescent lamp is
	 Fluorescent lamp	 Setting for an environment in which a 	

			   fluorescent lamp is
Sharpness

	 Normal	 Normal setting
	 Sharp	 Big change in the colour and brightness of the 	
		  image. The image appears sharper.
	 Soft	 Small change in the colour and brightness of the 	
		  image. The image appears softer.

Quality of images to be saved

	 Extremely fine		 The highest quality of image
	 Fine		  Standard setting
	 Normal		  The smallest size of the file

Settings for still image recording / system settings

Set the exposure between  
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Time stamp
A time stamp can be inserted into the data to be saved. This saves the 
date and time.
	 On	 Activate the time stamp
	 Off	 Deactivate the time stamp
	 Time setting	 Set the time
Another screen opens, in which the time is set.

Automatic switch off
When not in use, the device switches off after a certain time.		
	 1 minute	 The unit switches off automatically after 1 minute.
	 3 minutes	 The unit switches off automatically after 3 minutes.
	 5 minutes	 The unit switches off automatically after 5 minutes.
	 Off	 Automatic switch off.

Language
Select the language of the system settings.

Frequency

Formatting
Formats the data on the SD card.
OK	 Starts formatting process
Cancel	 Cancels formatting operation

Factory settings
Reset all settings
OK	 Resets all settings to factory default
Cancel	 Cancels the process

6. Software (ViewTer Plus)
You can use the included software "ViewTer Plus" to edit and measure 
the saved data. Please read the information below about the installation 
requirements.
Minimum requirements
Operating system		  Windows 8,7 (32bit / 64bit)
			   Windows XP SP3 Vista (32bit Version)
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CPU				    Pentium III 1Ghz or higher
Optical drive			   Necessary
Main memory			   over 256 MB
Required memory space		  over 1000 MB
Connection type			   USB 1.1/2.0
Display size			   15“ (XGA) or more
Graphic				    16 Bit colour or more
Rights				    Administration rights (during  
				    installation)

Recommended requirements
CPU				    Pentium 4 1.6 Ghz or higher
Main memory			   512 MB or more
Required memory space		  10 GB or more
Display size			   17” (SXGA) or more
Graphic card			   16 Bit colour, Video memory 	
				    64 MB or more

6.1 Installing the software
Antivirus software may interrupt the installation process. If this happens, 
please disable your computer's antivirus software until the installation is 
complete.

Press "Continue anyway" if UAC (User Account Control) is activated. The 
installation menu opens after you have inserted the installation CD into 
the CD-ROM drive. Then click "Install Software".
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If the installation menu does not open automatically, open my "My 
Computer" -> "CD-ROM" and then click "autorun.exe".

The installation programme will open now. Please click "Next".

The End User Licence Agreement is displayed. Click "I accept" and then 
click "Next".
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The screen where you can change the installation folder is shows. Click 
"Next".

Click "Install" to start the installation.

Click "Finish" to end the installation.

6.2 Transmitting / Deleting the recorded data
You can use ViewTer Plus to edit recorded data that has been transmit-
ted to the computer. To do this, move the data to the desired folder.
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Recording with ViewTer

Connect the enclosed mini-USB cable to your computer.

When the ViewTer is connected to the computer, "Card Reader Mode" is 
displayed on the screen. The unit is displayed as a "Removable Disk" on 
the computer.

Card reader mode
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Click on the following icons one by one to open the folder with the 
saved data. The recorded data are saved in the folder "100DSCIM".

The icon of "Removable Disk" may look different depending on the type 
of computer. If you are using your own SD card and the folder name has 
been changed, the folder name may have a different name.

Now open the image folder in ViewTer Plus. Follow the steps below:

Or:
8/7/Vista C: Users > (User name) > Documents 
XP C: Documents and Settings > (User name) > My Documents
Move the recorded data from "100DSCIM" to the images folder.

100DSCIMDCIM

100DSCIM
In "Removable Disk"

Bilder Ordner
In "My Documents"
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6.3 Using ViewTer Plus
Now you can use the software. Open "ViewTer Plus".

File summary
Click on "Open" in the "File" tab of the menu bar. The files are now 
displayed on the left side of the window.

File
The saved data is showed after you have opened the folder with a dou-
ble click. If you want to enlarge or reduce them, use "Zoom In" or "Zoom 
Out" in the "Image" tab in the menu bar.

A control bar is showed for the video mode.
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Editing
ViewTer Plus allows you to edit the currently displayed image. You can 
save the edited data by clicking on "Save as" in the "File" tab.

Flip the current image horizontally
Flip the current image vertically

Rotate the image 90° clockwise
Rotate the image 90° counterclockwise
Intensifies the sharpness
Reduce the sharpness
Activate the image embossing

Change the colour of the image to monochrome
Activate the greyscale
Invert the colours of the image

Menu bar, tab "Colour"
Under the tab "Colour" the colour of an image can be changed.

Menu bar, tab "Image"
Under the "Image" tab, you can edit the currently selected image.
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Measuring functions
You can use ViewTer Plus to insert measurements into the taken images. 
Each measurement function can be found in the "Measurement" tab in 
the menu bar.

Standard dimensions are set

Measures the distance between two points
Measures the length of a continuous line
Measures the length of a dotted line

Measures the length of a radius
Measures the length of a diameter
Measures a circle through three points

Measures the size of an arc
Measures the size of a triangle

Measures an angle with 3 points
Measures an angle with 4 points

Change the font of the text etc.
Deleting the calibration data	

Next, click on two points that you want to measure. As an example, click 
on the lower part and the upper part of the "L" to measure the height.

Using the measurement functions (e.g. length of a line).
Select "Measurement Line" in the "Measurement" tab.
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Some measurements require three clicks.
Click anywhere in the image and the measurement data become visible.

Calibration function
Use "Calibration" to calculate more precise data. To do this, take a still 
image of the measuring scale included in the delivery.

Select "Measurement Calibration" in the "Measurement" tab.

Please click on two lines of the scale where the size is known.

Enter the correct size in the new window and click "OK".
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The values are displayed on the left side of "Magnification". From now 
on, measurements will be made based on these values.

Line settings
Select "Settings" in the "Measurement" tab to open the window shown 
below. In this window you can set the font, font colour and the line 
colour.
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7.  Advices and FAQ

Reference:
• Pictures and screenshots in this manual
The images and screenshots in this manual were taken in the process of 
developing the product.
• Trademark
The product name in this manual is a registered trademark.

Troubleshooting:
• I cannot turn the ViewTer on or off
Look on page 7 (charging) and follow the steps. Also check if the charg-
ing light is on. Please turn the LED controller and check if the LED light is 
on. Also press the menu button and check if the menu screen will be dis-
played. If the screen freezes during the starting process, please press the 
release button and the "-" button at the same time to reset the ViewTer.

• No graphic.  The focus could not be adjusted. 
Turn the controller and test if the displayed image changes. The focus of 
the ViewTer is a monofocal point. Please refer to the image on page 8 to 
change the distance between the ViewTer and the object.

• SD card is not read/data cannot be saved. 
Is the SD card inserted correctly? Please check if the SD card has been 
inserted correctly and if the adapter for micro SD cards is working prop-
erly. Format the SD card with your computer or any other device except 
the ViewTer before inserting the card into the unit.
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8. Specifications

Image sensor 1/3 Inch 5 Million Pixel CMOS Sensor 

Focus distance 0~60 mm (with lens covers)

Magnification x10~200 

Digital zoom Maximum x4

Still image format JPEG

Still image resolution 2560x1920/2048x1536/1600x1200/1280x960/
640x480

Video format AVI

Video resolution 640x480/320x240 

Light source ViewTer500UV: White LEDx4 / UV LEDx4 
ViewTer500IR: White LEDx4 / UV LEDx4	

LED ViewTer500UV: wavelength 395 nm;  
                              frequency 0.59, 10-14 Hz   
ViewTer500IR:  wavelength 850 nm;  
                             frequency 3.53, 10-14 Hz

ISO sensitivity 100/200/400 

Monitor 3.5" LCD monitor, resolution 320x240 px

Saving the data SD/SDHC Card, maximum 32 GB

Battery Battery rechargeable (1800 mAh internal LI-ON 
battery)

Charging time Around 5 hours

Duration of use Maximum 4 hours

Possible charging cycles Around 500

PC Connection USB1.1/2.0 

Operating temperature -10° - 40° C

Air humidity less than 85%

Weight About 170 g (without SD card)

Dimensions About 117mm x 75 mm x 67 mm
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9. Safety advices

Please read the following instructions carefully before use to avoid 
danger.

DO NOT store or use the product in direct sunlight or under high tempera-
tures. Doing so would cause the battery to expand or explode.

DO NOT look directly into the LED light source. 

DO NOT use the product with wet hands or in humid conditions. This could 
result in an electric shock.

DO NOT disassemble or modify the product. This could result in electric 
shock or fire hazard.

DO NOT use organic solvent, alcohol or thinner for cleaning.

DO NOT use additional units as a power supply. There is a risk of fire or 
electric shock.

DO NOT insert fingers into the lens part. Do not point a light source directly 
into the lens. This could damage the lens.

Rechargeable batteries are installed. Please note this for proper disposal.

Warning
Disregarding the following instructions can 
lead to serious injuries!
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